The Complete Handbook of

jv16 PowerTools X
Foreword

This digital book can be distributed freely without permission from the author either in digital or print form.

Please visit www.macecraft.com for updates to this book.

The product version used for writing this book is a pre-release version using the Advanced Mode. Your particular interface and the names of the features may differ slightly. If you are using the program in the Simple Mode, the default setting, you will see a more simplified user interface in some screens.

Microsoft, Microsoft Windows, Windows NT, Windows ME, Windows 2000, Windows XP, Windows Vista, Windows 7, Windows 8 and Windows 10 are trademarks or registered trademarks of Microsoft Corporation. All other trademarks and product names are the property of their respective owners.

All the icons used in this document are provided by the Open Icon Library project.

Copyright 2005–2015 Jouni Flemming. All rights reserved.
# Table of Contents

Foreword ........................................................................................................................................2  
Introduction to jv16 PowerTools X ................................................................................................6  
  Minimum System Requirements .................................................................................................6  
  Recommended System Specifications .........................................................................................6  
  Design Goals .............................................................................................................................6  
  Safety First .................................................................................................................................8  
  The User Interface .....................................................................................................................9  
Introduction to the Registry .........................................................................................................11  
  Registry Structure ....................................................................................................................11  
Tagging ..........................................................................................................................................12  
jv16 PowerTools X Set-Up ............................................................................................................13  
  User Interface ..........................................................................................................................14  
  User Interface Details ................................................................................................................15  
  Installation .................................................................................................................................17  
Advanced Settings ......................................................................................................................19  
Security ........................................................................................................................................21  
Backups .........................................................................................................................................22  
File Wiping ....................................................................................................................................24  
Abbreviation ................................................................................................................................26  
Preferences Saving .......................................................................................................................28  
Integration with Windows ............................................................................................................30  
Action History .............................................................................................................................31  
Main Tools of jv16 PowerTools .....................................................................................................32  
  Main Window: the Home Screen ...............................................................................................33  
  Main Window: Registry Tools ....................................................................................................35  
  Main Window: File Tools ...........................................................................................................37  
  Main Window: System Tools .....................................................................................................39  
Clean and Fix My Computer .........................................................................................................41  
  Clean And Fix My Computer – Results Screen ......................................................................43  
  Fixing Found Errors ..................................................................................................................44  
Startup Optimizer ........................................................................................................................46  
Startup Manager ..........................................................................................................................48  
Software Uninstaller ....................................................................................................................50  
Immunize my Computer ...............................................................................................................52  
Decrap my Computer ...................................................................................................................54  
Registry Manager ..........................................................................................................................55
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registry Finder</td>
<td>57</td>
</tr>
<tr>
<td>Search Methods</td>
<td>58</td>
</tr>
<tr>
<td>Perl Regular Expressions Quick Guide</td>
<td>60</td>
</tr>
<tr>
<td>Registry Find &amp; Replace</td>
<td>61</td>
</tr>
<tr>
<td>Results Window</td>
<td>63</td>
</tr>
<tr>
<td>Registry Monitor</td>
<td>64</td>
</tr>
<tr>
<td>Creating a New Snapshot</td>
<td>66</td>
</tr>
<tr>
<td>Comparing Snapshots</td>
<td>68</td>
</tr>
<tr>
<td>Comparison Results</td>
<td>70</td>
</tr>
<tr>
<td>Registry Compactor</td>
<td>71</td>
</tr>
<tr>
<td>Registry Information</td>
<td>72</td>
</tr>
<tr>
<td>File Finder</td>
<td>73</td>
</tr>
<tr>
<td>File Cleaner</td>
<td>75</td>
</tr>
<tr>
<td>File Recovery</td>
<td>77</td>
</tr>
<tr>
<td>File Organizer</td>
<td>79</td>
</tr>
<tr>
<td>Duplicate File Finder</td>
<td>81</td>
</tr>
<tr>
<td>File Tool</td>
<td>83</td>
</tr>
<tr>
<td>Mass File Renamer</td>
<td>86</td>
</tr>
<tr>
<td>File Attribute Tool</td>
<td>88</td>
</tr>
<tr>
<td>Find &amp; Replace</td>
<td>89</td>
</tr>
<tr>
<td>The Find &amp; Replace Results</td>
<td>90</td>
</tr>
<tr>
<td>File Encrypter</td>
<td>92</td>
</tr>
<tr>
<td>File Analyzer</td>
<td>94</td>
</tr>
<tr>
<td>Directory Finder</td>
<td>96</td>
</tr>
<tr>
<td>Directory Tool</td>
<td>98</td>
</tr>
<tr>
<td>Disk Wiper</td>
<td>100</td>
</tr>
<tr>
<td>History Cleaner</td>
<td>102</td>
</tr>
<tr>
<td>Automation</td>
<td>104</td>
</tr>
<tr>
<td>Service Manager</td>
<td>106</td>
</tr>
<tr>
<td>Appendixes</td>
<td>108</td>
</tr>
<tr>
<td>Command Line Parameters</td>
<td>108</td>
</tr>
<tr>
<td>Security Notes</td>
<td>109</td>
</tr>
<tr>
<td>Installing the Handbook and languages</td>
<td>109</td>
</tr>
<tr>
<td>Frequently Asked Questions – with their answers</td>
<td>110</td>
</tr>
</tbody>
</table>
Introduction to jv16 PowerTools X

jv16 PowerTools X is a utility suite which easily allows you to clean, optimize and repair your Microsoft Windows based computer. jv16 PowerTools offers a large range of tools that provide a safe and powerful method of getting “under the hood” of your computer.

Minimum System Requirements

- Mouse and keyboard

Recommended System Specifications

- Mouse and keyboard
- Internet connection to receive updates and check for new product versions

Design Goals

1. **Safety.** We take safety very seriously. There can be no point in optimizing or cleaning your computer if that action creates problems. Since the inception of RegCleaner, first developed in the late 1990s, we have had the policy of operating on the side of caution: missing some potential registry errors to prevent incorrectly deleting one valid registry entry.

2. **Performance.** We strive to find a balance between thoroughly analyzing the data while optimizing our software to perform as fast and efficiently as possible.

3. **User friendliness.** Our software is a guest on your computer, and our program should act accordingly. This means that jv16 PowerTools does not integrate into your system, does not fill your system directories with its files, and does not automatically start with the Windows operating system. If you choose to uninstall jv16 PowerTools, nothing is left behind.
In addition to English, jv16 PowerTools comes installed with several common languages. You can change the entire user interface from one language to another with just two clicks of the mouse. You can also create your own translation by simply editing a single text file.
Safety First

jv16 PowerTools X is a powerful utility suite. Yet, even the most novice users can safely reap the benefits from its power by understanding a few simple principles.

When you run jv16 PowerTools, it only makes suggestions based on its analysis. You, as the user, always have control in the cleaning and optimizing of your computer. Make sure that you clearly understand any operation that you are about to perform. If you are not familiar with an operation, or cannot identify the results of a scan, it is always the best option to leave those items untouched. Consult the manual for more information or clarification.
The User Interface

jv16 PowerTools might look somewhat different from other Windows software. One difference is that jv16 PowerTools uses check boxes in its scan results. The check boxes allow the user to easily select a number of items. Just click the check box to place a tick on it in order to select it. Clicking anywhere else on the row highlights the item.

jv16 PowerTools X contains hundreds of different features. In order to keep the user interface clean and uncluttered, only the most common features are shown as toolbar buttons or icons.

All the main features of the program can be accessed from the Main Window, which organizes the main tools into different categories. In addition to the Main Window, you will find several more features in the File Tool and the Directory Tool.

jv16 PowerTools uses check boxes to define which items are “selected” and which are simply highlighted. Some features, such as Right-Click > Explore, work with the currently highlighted item, that is, the item you have right clicked, while other features work with all selected items that are ticked or checked.
To make it easier for you to see which features are being applied, the Right-Click context menus show you which items of the list they access. This can be seen from the following screenshot:

As seen from the screen shot above, all the features that are used to modify the selected items of the result list contain the check box icon on far right. All the remaining features work with the currently highlighted item.

**Tip:** You must be logged in as the computer's administrator when using jv16 PowerTools X. The product cannot operate properly without full system rights.
Introduction to the Registry

This chapter gives you some basic information about the Windows registry. If you are already familiar with the subject you may skip this chapter.

Every Windows–based system has a feature called the registry. Many software applications, including the operating system itself, store their settings data – for example, a user's preferences – to the registry. This makes the registry a vital part of your system.

Registry Structure

The registry is organized in a hierarchical tree structure comprised of sub trees, their keys, hives, and value entries. Here's an example of what a single registry key looks like:

```
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion
```

The first part of the entry, "HKEY_LOCAL_MACHINE", is the root key, also known as the root hive. It's just like the drive letter in a file system.

The remaining part of the entry is the registry key, "Software\Microsoft\Windows\CurrentVersion", which is comparable to a directory path in a file system.
Located under these keys there are registry entries which are used to store the actual data. These are like files in a file system. Each registry entry has a name and contents, the actual data or value.

**Tagging**

Tagging allows you to freely create and assign tags to items in lists, such as result listings in Clean And Fix My Computer tool, Startup Manager and most other tools.

To access the Tag Editor window, select the item or items you wish to tag, then double-click on the rightmost column in the list (the column that says 'Tags').

In the Tag Editor, simply check the tag or tags you wish to assign to the selected list items. To create a new tag, simply type its name and click 'Add tag'.

You can also rename and delete tags by right-clicking on a tag in the tag list and choosing the appropriate option from the context menu.

The tag listing also contains some built in tags which cannot be deleted or renamed. You can still assign these freely as you would any of your own tags.

Tags are saved when you exit, so they will show up again in subsequent uses of the program or tool.
**jv16 PowerTools X Set-Up**

Most novice users can use jv16 PowerTools' default settings, and can skip this chapter. Power users may use this chapter to help customize their setup.

To access the settings of the application, start jv16 PowerTools and either:

- choose File > Settings, or
- press Ctrl+S while in the main window, or
- click on the **Settings** icon also while in the main window.
The **User Interface** panel allows you to change the look of jv16 PowerTools X.

- **Program mode**: The two modes determine the set of tools available to the user. Simple mode is enabled by default and is designed for the average user.

- **Font** sets the fonts for the interface. Note: Changing the font settings is not recommended unless the character set used on the system doesn't work well with the default font.
User Interface Details

The User Interface Details panel allows you to change many specific items relating to how the product's user interface works.

The following settings are available for Internet access:

- **Automatically check for program updates** – Look for updates when the program is launched. If a new version is found, the program shows you more information without automatically downloading or updating.

- **Automatically check and download updated translations and other files used by jv16 PowerTools**
• Allow Immunize my computer feature to check for hosts file updates when used

The following settings are available for Main window:

• **Show the Home feature in the Main window**
• **Use click and fade effects for the tool icons**
• **Use fade out effect for the tool windows** – These two options allow you to turn off some of the “eye candy” that some users may find distracting.

The following settings are available for List options:

• **Allow tags to be added to lines** controls whether the new tagging system is enabled.
• **Click anywhere on a line to select it**
• **Click anywhere on a line to deselect it**
• **Highlight selected lines**
• **Show invalid file, directory and registry references in red**
• **Show valid file, directory and registry references in green**
The Installation panel contains information on which directories jv16 PowerTools should use.

Please make sure there are sufficient user rights to these directories if the directories are located on a NTFS partition.

Note that if you modify the directory paths you must manually copy the directories' contents to the new location if you wish to keep the directories' contents intact.

You can not change where jv16 PowerTools will place its temporary data – the default system
The temp directory is always used. By default, it is \%TEMP\%\jv16PT_X\. If it is not possible to create a sub directory called jv16PT_X there, the root of the Temp directory is used (\%TEMP\%).

The relational paths, such as “\Settings\” are relative to the program's installation directory. For example, if you have installed the program to “C:\Program Files\jv16 PowerTools X” the “\Settings\” refers to “C:\Program Files\jv16 PowerTools X\Settings”.
The Advanced panel contains the following settings:

- **Default file viewer** sets the default file viewer when clicking the View function in File Tool's "More Functions" menu. It's also used to view the contents of registry backups in the Backup Tool. You may change the default file viewer but note that not all file editors can be used. The editor must support opening files with the following command line: Application.exe "file_to_be_opened.txt" – for example notepad.exe "C:\readme.txt".

- **Registry editor** sets the default registry editor. Note that not all registry editors can be used as the default registry editor. The registry editor must use the same method to
open the desired registry key as the Windows Registry Editor. This can be tested very
easily: simply change the default registry editor setting to the desired third-party
registry editor and test if “Open in RegEdit” works.

- **Settings directory** determines date formatting. The default date format is
  “DD.MM.YYYY, HH:NN”. Note that the MM refers to months, and NN to minutes. The list
  contains some of the most common date formats, but you can also create your own
date format.

- **Global Ignore List** is used to define program wide ignore words. For example, if you
use a system critical software called “Foobar”, you could add that to the Global Ignore
List and no feature of PowerTools will edit or remove any data related to that software.
The Security section allows you to password protect and restrict the usage of the product. The following security options are available:

- **None.** The default setting; all users have unlimited access to the product.
- **Always ask password when the program starts.**
- **Ask password only when the normal GUI is started.** This option allows the use of automated tasks and the Privacy Protector without the password.
- **Ask password only before removing data.**
The Backups panel defines how the backup files will be created.

The Backup policy section offers the following options:

- **Always create a backup before removing or modifying anything** – Create a backup of everything you delete or modify without confirmation.
- **Always ask me if I want a backup to be created**
- **Never create any backups** – Using this option is not recommended.

The Backup descriptions section options are:

- **Generate and set the description automatically** – The way the description is
generated is not identical for tools, but usually the description is generated from the
data of the first selected item.

- **Generate the description automatically and display it for editing** – Verify the
  automatically generated description since they are not always very clear and
  informative.

- **Always ask me for the description** – Write your own backup description.

Backup removal options define whether you want the backups to be deleted by normal file
deletion or by a safe file wiping procedure. Wiping a file writes over the file several times with
random data so that its contents can not be reconstructed or recovered. You can control the
level of random overwrites in the File Wiping section of the Settings tool.
The File wiping settings allow you to define how many times the data should be written over. The more overwrites the safer. However, as you increase the number of overwrites, you also increase the time it takes to delete the file.

The overwriting procedure works the following way:

1. Overwrite the data with zero bits.
2. Overwrite the data with one bits.
3. Repeat steps 1 and 2 until the desired number of overwrites is done.
4. Overwrite the data with random bits.
5. Repeat step 4 until the desired number of overwrites is done.
6. Write the file's or directory's name over with random data 255 times.
7. Delete the data from the disk.

All used file buffers are flushed after each write to ensure all the data is actually written to the disk. These settings are used in several tools of the product, such as the Wipe feature of the File tool, Directory tool, and the Disk Wiper tool.
Abbreviation

Shorten the way PowerTools displays long registry paths, such as “HKEY_CURRENT_USERS\Software\Microsoft\Windows\”, with the Abbreviate settings.

The following options are available:

- **Abbreviate long registry path names in the Clean and Fix My Computer**
- **Abbreviate long registry path names in the Registry Finder**
- **Abbreviate long registry path names in the Registry Find & Replace**
The product supports two methods of abbreviation.

- **Abbreviate the root key** modifies only the root key, eg. “HKEY_CURRENT_USER” to “HKCU”.
- **Also abbreviate other common parts of the registry path** can modify all parts of the registry path. This can dramatically reduce the space needed to show the registry path information but inexperienced users may find the abbreviated registry paths difficult to read.
Preferences Saving allows you to save the search settings of File Finder for later use. This enables you to perform multiple similar searches without the need to configure the tool each time you use it.

If enabled, the Preferences Saving feature adds a small toolbar to some of jv16 PowerTools' windows as shown in the following image.
The toolbar has three simple but useful features:

1. Load a previously saved set of preferences (such as search options of the File Finder) by selecting it from the drop-down list.
2. Save the current set of preferences by clicking the small disk icon on the upper left.
3. Delete the currently selected previously saved set of preferences by clicking the red icon on the lower left.
Integration with Windows settings allows you to define in which ways jv16 PowerTools is integrated to the system. You can create (and remove) icons relating to jv16 PowerTools to your Windows desktop, as well as to the Start menu.
Action History contains records of the actions and changes to the system you have made using the various tools within jv16 PowerTools. The action listing is sorted first by tool, then by date the action was performed.

Additional information about each action is shown in the Item column. The contents of this field vary depending on the action it refers to. You can use the Right-Click menu to locate the backup relating to the specific action, such as removal of a file.
Main Tools of jv16 PowerTools

jv16 PowerTools contains hundreds of features and tools. The Main Window is your starting place to access the most commonly used tools. Most of the software's other features are available from the File Tool and Directory Tool windows.
Main Window: the Home Screen
The Main Window of jv16 PowerTools contains shortcuts to the main features of the program:

- **Clean and Fix my computer** – This tool performs all the cleaning and fixing operations that can be automatically done to your computer.
- **Uninstall software and leftovers** – See all the software installed on your computer and uninstall software you no longer need.
- **Speed up my computer** – Improve the performance of your computer by turning off unused system features.
- **Control which programs start automatically** – See and modify which software automatically launches when Windows starts up.
- **Immunize my computer** – Improves the safety of your system by blocking your computer from accessing known hazardous websites.
- **Decrap my computer** – Improves the safety and increases speed by removing bloatware from your computer.

**Tip:** You can drag and drop files to the Main Window. If you drop files they are listed in the File Tool. If you drag directories they are listed in the Directory Tool. If you drag both files and directories, the files and all the files from the directories are listed with the File Tool.
Main Window: Registry Tools
The main Registry Tools in the program include:

- **Registry Manager** – Modify specific parts of the Windows registry.
- **Registry Finder** – Search with a rich set of option for data in the registry.
- **Registry Find and Replace** – Find and replace data directly from the Windows registry.
- **Registry Compactor** – Reduce the size of the registry without removing any data, by rebuilding the registry database in a more efficient manner.
- **Registry Information** – See detailed information about the contents and structure of the registry.
- **Registry Monitor** – Create and compare different snapshots of your current registry.
Main Window: File Tools
File Tools include:

- **File Finder** – Search for files on your computer. This tool supports a wide array of search parameters.
- **File Cleaner** – List all the temporary files on your computer.
- **File Recovery** – Restore deleted files.
- **File Organizer** – Quickly organize file collections.
- **File Tool** – A general purpose file tool: list files for other tools, file encryption, file wiping, batch file renaming, search and replacing data within files, among other utilities.
- **Duplicate File Finder** – Find files with absolutely identical content.
- **Directory Finder** – Similar to File Finder, but for directories with a complete set of search options.
- **Directory Tool** – Perform various actions on the listed directories.
- **File Organizer** – Allows you to automatically create folders for groups of files.
- **Mass rename files** – Allows you to rename many files at the same time based on an user–defined pattern, such as “image1.jpg”, “image2.jpg” and so on.
- **Merge files** – Allows you to combine files with each other.
- **Split files** – Allows you to split large files into smaller pieces.
- **Remove files on reboot** – Allows you to define files or folders to be removed the next time your computer starts. This feature can be used to delete files that are normally locked and cannot be removed.
- **Find and replace data inside files** – Allows you to search for and replace data within text files.
- **Wipe files** – Allows you to delete files and folders by wiping them, so that the data cannot be ever recovered.
Main Window: System Tools
The System Tools panel contains the following:

- **Automation Tool** – For advanced users, automate various PowerTool tasks
- **History Cleaner** – Improve your privacy and remove wasted space by clearing the 'history' and 'Most Recently Used (MRU) data stored by the Windows operating system and other installed software.
- **Disk Wiper** – Overwrite files before deleting them to permanently remove a file from your computer. No file recovery program should be able to reconstruct the contents of the original file.
- **Startup Manager** (also available from the Home screen) – List all software that is set to automatically start with Windows. Reduce boot time by editing this list.
- **Service Manager** – List all Windows services and disable or delete unnecessary ones.
- **Startup Optimizer** – Makes your computer start faster and smoother without removing anything from your system.
- **Software Uninstaller** (also available from the Home screen) – List all the software installed on your system including leftover traces of old software. The tool can also uninstall software using both the system's uninstaller and PowerTools' own, custom software uninstallation engine.
The Clean and Fix My Computer tool allows you to run the History Cleaner and File Cleaner simultaneously, displaying their results in a single results window.

The tool contains many settings you can change to ensure optimal performance. However, the most important setting is the setting for aggressiveness. If you are unsure, do not change that option. The more aggressive scan modes are more risky to use and you should only use them if you suspect your computer needs an extra deep cleaning and you know how to recover in case something goes wrong with the aggressive cleaning.
Features:

- **Additional Safety** – Use this feature to ignore all data relating to applications such as backup software, anti-virus software and other applications you may want to leave untouched.
- **Ignore Words** – Set the tool to ignore words and phrases from your created list for additional safety. You can create single words or phrases separated by a line.
- **Search Words** – Narrow your search to specific items. Search terms can be single words or phrases entered one per line.

**Clean And Fix My Computer – Results Screen**
The Clean and Fix My Computer results screen organizes its results in easy to access categories. With 'tags' you can easily add notes to remind you if the item is an old, new or keeper.

**Tip:** You can use the List Control menu from the Right–Click menu to collapse or expand groups. Alternatively, with the list selected, simply starting to type will activate the List Filter feature!
The Result Screen of Clean and Fix My Computer displays the following data columns:

1. Item
2. Severity
3. Description

The Item column displays the system related problem category names. Once they are expanded, each category will showcase the individual errors or otherwise redundant data that Clean and Fix my Computer has identified.

The Severity column displays the level of impact of the respective error or invalid data on the overall performance of your system.

The Description column displays on each line the short description of item specific error item or file marked for cleaning (such as its type or file path).

**Fixing Found Errors**

When Clean and Fix My Computer has completed its scan you have three options:

1. Delete the found errors.
2. Fix the found errors.
3. Use the Custom Fix feature to fix the errors found.

The simplest solution is to repair found errors with the Fix button. It automatically attempts to correct the errors. If no fix is found the feature deletes the erroneous registry data.

You can also use the Custom Fix feature. Simply select all items with Select > All (or by pressing Ctrl+A), and click the Custom Fix button on the bottom of the window. After a few seconds, a dialog opens which allows you to select how you would like to fix the problem.
The fixing tool also contains other fixing method for advanced users, such as the Fix manually feature which allows you to modify the erroneous data by hand and then insert it directly into the registry. One should be very careful with this feature. If you think that the item listed is not erroneous and shouldn't be listed at all, you can select Don't show this item ever again.

**Information:** A general rule on how to use the fixing tool: select Automatically select the best possible solution if you can. Otherwise select the Delete the item and click OK. Automatically select the best possible solution is enabled only when the application can automatically detect a way to fix the error.
Startup Optimizer

The Startup Optimizer makes your computer start faster and smoother without removing anything from your system.

Using the Startup Optimizer is very simple and safe: select whether you want to enable the Startup Optimizer and click OK. The next time you start your computer, you will see it start up
faster and smoother!

Enabling the Startup Optimizer integrates the Startup Optimizer code to Windows startup process to make it faster and smoother. Using the Startup Optimizer does not remove anything from your computer. All the software still start with your computer and no software is uninstalled.

Tip: Because the Startup Optimizer integrates to the system startup process, it must be disabled if you ever wish to stop using jv16 PowerTools X. Running the software's Uninstaller will automatically also unistall the Startup Optimizer. If you want to manually remove jv16 PowerTools by deleting its installation folder, be sure to disable the Startup Optimizer first!
The Startup Manager lists all applications that are set to automatically launch when you boot your computer. The tool analyzes the registry and the Windows Start Menu to locate the applications. Obsolete startup definitions such as Win.ini are not analyzed.

Clicking on a list item provides more information about the software. You can learn whether it is currently running and its load path. If you have enabled the network usage, the Description field shows more information about the software downloaded from Macecraft's server. If
network access is not enabled, the Description field will instead show data extracted from the resident software itself.

You can also control which software automatically starts with the operating system from the Startup Manager. To improve system performance you should keep this list relatively short. Use the Disable button to prevent an application from starting automatically. The application remains on the list unless you use the Remove button to delete the software from the list. Use the New button to add your own software to the list.
Software Uninstaller

PowerTools X's Software Uninstaller improves upon the Add/Remove Programs feature of Windows. Windows' Add/Remove Programs tool depends on new software registering itself upon installation. However, since the operating system does not require this registration, the internal list may not list all the installed software.

The Software Uninstaller works around this shortcoming by:
1. Reading the same internal software list used by the Add/Delete feature.
2. Analyzing the registry for common software data.
3. Analyzing all hard drives to attempt to detect any other installed software.

Note that the Software Uninstaller makes some approximations when determining what software is installed. The list can contain some errors, for example a program's Main Executable information or Installation Date may not be shown correctly. This is not of appreciable concern.

**Warning:** Always validate the given information about the software, such as the author, the name of the software, its installation path, and the location of its main executable. If any of this information is incorrect, the tool may list entries unrelated to the software. If you are unsure about any piece of information, simply leave the box empty. Attempting to detect and remove software using generic search terms or names can be dangerous to your system.
Immunize my Computer allows you to easily improve the security of your computer. Once done, the immunization blocks your computer from accessing known malicious websites. This is achieved by listing known malicious websites to the so called hosts file of your system. The host file is used as a blacklist, therefore jv16 PowerTools doesn't need to be running in order for the protection to be enabled.
The data of known malicious websites is provided by http://winhelp2002.mvps.org/hosts.htm

If you wish to remove the lines added to the system hosts file by jv16 PowerTools X, you can do this from the Backup Tool (Tools menu > Windows hosts file > Remove all lines added by jv16 PowerTools).

If for some reason you wish to undo the immunization done by jv16 PowerTools X to your computer, you can do this from the Immunize my Computer tool. Once the immunization has been applied, the **Undo immunization by jv16 PowerTools** button will become available.
Decrap my Computer

The Decrap my Computer tool was designed to ease the task of removing all the unwanted, pre-installed software that ship with new computers. But the tool can also be used with any old computer to easily uninstall many software at the same time.
Registry Manager

The Registry Manager for advanced users provides a simple interface to the Windows registry. It contains many tools for manual registry repair and maintenance. You can edit the Windows Add/Remove Software menu, delete leftover registry entries from previously uninstalled software, edit or delete shell extensions and more.

Registry Manager Features:

- **Add/Remove menu** shows the items from Add/Remove Programs in the Windows Control Panel. The feature also lists the hidden items which are normally not visible in Add/Remove programs. Note that the Delete button only removes software from this list.
without uninstalling it from your system. Use the Uninstall button to remove software from your computer. You can only uninstall one application at a time. Note: The Uninstall button calls the system's own uninstaller application. To perform a full software uninstallation, use jv16 PowerTools' Software Uninstaller. It uses Windows' uninstaller, augmented with PowerTools' uninstaller engine.

- **Filetypes** lists registered files by type. It is fairly common for programs to leave their file type registrations behind when they are uninstalled.

- **New file** shows you a list of file types you can create using right-click > New menu. Note that if you still use the program whose shell extension you wish to delete from the right-click menu the program will often automatically recreate the entry the next time the program is used. (Not in WIN 7 or WIN 8)

- **Shell extensions** lists all registered shell extensions. Shell extensions are operations you can perform on certain types of files. For example, you can view a text file (.txt) with Notepad by double clicking it but you can also print its contents by right clicking it and selecting print from the right-click menu. You can delete all unwanted shell extensions.

- **IE context menu** shows all the context menu tools in Internet Explorer. Context menu extensions list additional tools available to you when you use the right-click context menu in the browser window. Some programs, such as FlashGet, create these kinds of new entries.

- **Open With menu** lists the same programs that Windows shows when trying to execute a file with an unknown file type.
Registry Finder

Searching for data in the registry is fast and easy when using the Registry Finder.

To start searching, simply type in your search word or words and click Start. Other sections of the Registry Finder offer more advanced settings for how you wish to run your search.

Search by date allows you to narrow you search to items which have been modified within a certain number of days, modified on a certain day, before a certain date, or after a certain date.

You have several available search methods:
• Normal, case insensitive, loose match search
• Case insensitive wild card search
• Perl regular expression search
• Artificial Intelligence search

These methods are detailed in the following section.

**Search Methods**

The following tables contains examples how the different search methods work. The following text is used in the examples:

> Then arose old Wainamoinen, with his feet upon the island, on the island washed by ocean, broad expanse devoid of verdure; there remained he many summers, there he lived as many winters, on the island vast and vacant, well considered, long reflected, who for him should sow the island, who for him the seeds should scatter.

<table>
<thead>
<tr>
<th>Method</th>
<th>Search word</th>
<th>Found first from</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>The</td>
<td>“Then arose old…”</td>
</tr>
<tr>
<td>Normal</td>
<td>wain</td>
<td>“Wainamoinen, with his…”</td>
</tr>
<tr>
<td>Wild card search</td>
<td>the</td>
<td>“Then arose old…”</td>
</tr>
<tr>
<td>Wild card search</td>
<td>?rose</td>
<td>“Then arose old…”</td>
</tr>
<tr>
<td>Wild card search</td>
<td><em>it</em></td>
<td>“With his feet…”</td>
</tr>
<tr>
<td>Wild card search</td>
<td>???nam*</td>
<td>“Wainamoinen, with his…”</td>
</tr>
<tr>
<td>Wild card search</td>
<td>up??</td>
<td>“upon the island…”</td>
</tr>
<tr>
<td>Perl RegEx</td>
<td>Then arose</td>
<td>“Then arose old Wainamoinen…”</td>
</tr>
<tr>
<td>Perl RegEx</td>
<td>sum+ers</td>
<td>“many summers, There…”</td>
</tr>
<tr>
<td>Perl RegEx</td>
<td>moinen$</td>
<td>“Then arose old Wainamoinen…”</td>
</tr>
<tr>
<td>Perl RegEx</td>
<td>f[ea]jet</td>
<td>“With his feet upon the island…”</td>
</tr>
<tr>
<td>Artificial Intelligence search</td>
<td>arise</td>
<td>“Then arose old Wainamoinen…”</td>
</tr>
<tr>
<td>Method</td>
<td>Search word</td>
<td>Found first from</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Artificial Intelligence search</td>
<td>oceans</td>
<td>“the island washed by ocean, Broad...”</td>
</tr>
<tr>
<td>Artificial Intelligence search</td>
<td>reminds</td>
<td>“There remained he many summers, ...”</td>
</tr>
<tr>
<td>Artificial Intelligence search</td>
<td>seed</td>
<td>“Who for him the seeds should scatter...”</td>
</tr>
</tbody>
</table>

Notes:
- If you don't enter any wild cards (the “*” and “?” characters) when using the wild card search the system automatically adds *'s at the beginning and at the end of your search word(s). For example, “the” would be interpreted as “*the*” and so on.
- The Perl regular expression search is case sensitive.
- The Artificial Intelligence search is not language dependent, it works the same way with all languages.
- jv16 PowerTools X uses the TPerlRe component by Luu Tran for its Perl RegExp implementation. TPerlRe is a Delphi wrapper for perlre.dll, the Win32 port of Philip Hazel's PCRE (Perl Compatible Regular Expression) package.
# Perl Regular Expressions Quick Guide

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Example of usage</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>sum+ers</td>
<td>Match one or more of the preceding character, therefore the example would match “summers”, “summmers”, “summmmmmmmers” etc.</td>
</tr>
<tr>
<td>.+</td>
<td>sum.+ers</td>
<td>Matches “summers”, “sumXers” but not “sumers”</td>
</tr>
<tr>
<td>.*</td>
<td>sum.*ers</td>
<td>Matches “summers”, “sumXers” and “sumers”</td>
</tr>
<tr>
<td>[]</td>
<td>jo[ha]n</td>
<td>Matches one of the letters inside the brackets, both “john” and “joan” in the example.</td>
</tr>
<tr>
<td>^</td>
<td>^ne</td>
<td>Matches any string which starts with the given string, the example matches “need”, “needle” and “necessary” etc.</td>
</tr>
<tr>
<td>$</td>
<td>ing$</td>
<td>Matches any string that ends with the given string, the example matches “interesting”, “using”, “patterning” etc.</td>
</tr>
<tr>
<td>?</td>
<td>to?l</td>
<td>Matches zero or one of the preceding character, the example matches “tool” and “tol”.</td>
</tr>
</tbody>
</table>

Further reading about Perl regular expressions can be found online. See:

- [http://www.weitz.de/regex-coach/](http://www.weitz.de/regex-coach/)
- [http://etext.lib.virginia.edu/services/helpsheets/unix/regex.html](http://etext.lib.virginia.edu/services/helpsheets/unix/regex.html)
- [http://www.regularexpression.info/](http://www.regularexpression.info/)
**Registry Find & Replace**

The Registry Find & Replace tool is a very convenient way to replace data in the registry.

An example of when to use this tool is when you need to correct disk drive paths. This need can arise when a new hard disk drive is added to your system, and all the drive paths are changed by Windows. Some programs may no longer work if the registry still shows that they are on, for example, the D: drive but are actually on the E: drive.

To fix the problem, simply write “D:\” as the search word and “E:\” as the Replace with word and click Start. You will be prompted to confirm any changes.

The Options section contains some options for advanced users. You can select which parts of
the registry you wish to be analyzed.

The Options tab contains the following options:

• **Use as little CPU power as possible** reduces CPU overhead and allows you to continue to work at your computer.

• **Analyze value names** – Data inside the registry is stored as key/value pairs, and just like with files you have the file name and the file's contents. This option tells the Registry Find & Replace tool to analyze not only the data, but also the name of the data.

• **Analyze value data** – Similarly to above, this tells the Registry Find & Replace tool to analyze the value's data.

• **Don't pop up the window after finished** disables the default pop-up window when finished.

• **Ignore Words** allows you to specify words to be ignored. If any of these words are found from the analyzed material the registry key or entry will be ignored.
Results Window

The results of the Registry Find & Replace search are shown in a new window.

Notice that the Registry Find & Replace tool hasn’t made any changes at this point, it only shows you what the data would become after the replace procedure. Go through the list and verify that all the items in it are items you wish to modify. To leave an item untouched, simply right click the item and select Delete from the list. You can also open the item of interest with the Windows Registry Editor by right-clicking the item and selecting Open in RegEdit. Once you have verified all the entries, click Replace and your changes will be applied.
**Registry Monitor**

The Registry Monitor is an easy way to control and monitor what goes on inside the registry of the system. You can create a snapshot of the current state of the registry and then use it for comparison later on.

The main window of the Registry Monitor lists all the current registry snapshots and allows you to manage them. The right-click context menu offers more features.

The Registry Monitor’s Compare feature can detect the following registry changes:
• Removal of a registry key
• Removal of a registry entry
• Modification of a registry entry's value
• Creation of a new registry key
• Creation of a new registry entry
Creating a New Snapshot

To create a new snapshot simply click the Create a snapshot button.

The more root keys you wish to include the slower the compare procedure will be. Selecting the HKEY_LOCAL_MACHINE and HKEY_CURRENT_USER root keys should suffice for most situations. After you are done selecting the root keys click Start. Then the software will ask you to give a description to the snapshot, as seen in the picture below. After naming the snapshot click OK and wait a few minutes for the tool to finish. Once the tool is finished, the window will close and you will see your new snapshot in the Registry Monitor's list.
Comparing Snapshots

To compare an old snapshot with the current status of the registry select the snapshot from the Registry Monitor's snapshot list and click Compare.

If you are only interested in seeing certain types of changes, for example the keys created by a newly installed application, you should use the Search words feature. This can dramatically increase the speed of the entire process.

The Search method contains the available search methods. Please read the chapter on Registry Finder for more information about the search methods supported by jv16 PowerTools X.

The following options are available:

- **Ignore MRU entries** ignores all unimportant registry entries that are frequently
• **Ignore system entries** ignores certain system registry entries that are modified frequently. Disabling this feature will slow down the process and may result in irrelevant information shown in the results window.

Click Start to begin. The comparison process involves the following steps:

1. Creation of a new temporary snapshot which contains the most recent data from the system registry.
2. Comparison of the user selected snapshot with the just-created temporary snapshot.
4. Display of detected changes.
Comparison Results

The Registry Monitor uses a new window for showing the changes it has detected.

You can use the results window to either delete the added items with the Delete button or revert any modified items to the earlier snapshot. Select the items to be changed back and click Change back. Care should be taken with this feature since it can alter some important system changes.
The Registry Compactor reduces the size of your registry without removing any data. This tool reconstructs the entire registry structure, eliminating unused disk space and redundant data. Compacting the registry reduces the amount of both RAM and hard drive space required by the registry.
The Registry Information tool shows detailed information about the registry and its contents. The Registry Information tool and the Registry Compactor provide different views on the size of the registry. Registry Information shows how much data the registry contains, while the Registry Compactor shows how much space it takes to store that data.
File Finder

If you wish to locate certain files on your computer, use the File Finder. It can search for files by name, extension, size, creation date, date of modification and date of last access.

The “Files to find” panel allows you to enter one or more wild card patterns and negative wild cards. For example, if you want to find all text files but not any files called Readme.txt, write “*.txt; -readme.txt”.

The “Search by size” panel allows you to define the size of the files in your search.
“About the same size as” uses a variance in size of about 5%. For example, if you are searching for files of 'about' 100 KB, the tools would list files whose sizes are between 95 KB and 105 KB.

“Search by date” allows you to search for files based on their creation date, last access date or last modification date.

“Search by attributes” offers a variety of extra filters that can be applied to the File Finder tool, such as for example “Look only for files with/without a read only attribute”.

“Search by contents” helps you to search for files based on their actual content.

“Search by owner” allows you to search for files based on the operating system user that owns them.

By design, jv16 PowerTools skips its own backup directory when doing file search operations.

The Options section contains the following:

- **Use as little CPU power as possible** will cause the tool to only use free processing time.
- **Skip deep directory structures to improve speed** will ignore subdirectories four or more levels deep from the original path.
- **Skip system directories to improve safety** will ignore files and subdirectories from the system directory.
- **Don't pop up the window after finished** disables the pop–up window when the tool is finished.
- **Ignore Words** specifies terms and phrases to omit from the search results.

**Tip:** You can use Ignore Words to exclude directories you don't want to be searched. For example, if you want to search all directories from C:\ but not C:\Windows, simply add C:\ to the Select from section and add C:\Windows to the Ignore Words section. Use this technique in other tools as well.
**File Cleaner**

Find obsolete and leftover temporary files with the File Cleaner. Remember to check the tool's results before deleting any file.

Use Engine settings to decide on the level of safety versus completeness of the results before starting.

The File Cleaner supports the following options:

- **Automatically delete all found files** – This feature is not recommended.
- **Use as little CPU power as possible** will cause the tool to only use free processing time.
- **Skip deep directory structures to improve speed** will ignore subdirectories four or more levels deep from the original path.
- **Skip system directories to improve safety** will ignore files and subdirectories from the system directory.
• **Don’t pop up the window after finished** disables the pop-up window after the scan has finished.
• **Ignore Words** specifies terms and phrases to omit from the search results.

You may also define which drives you wish the File Cleaner to analyze. Selecting all drives gives you more results but slows down the process.
File Recovery

When you delete a file it is not actually removed from your hard drive. Instead the file's area on the disk is marked as free so that it can be overwritten in the future. The File Recovery tool attempts to find files that have not yet been completely overwritten.

The File Recovery has the following options:

- **The Files to find section** – Enter a search pattern or patterns to which the files must match in order to get listed.

- **Search by condition** – Define whether the tool should only list files that can be recovered within a certain probability. For example, you can limit the listed files to ones that can be restored with 95% probability.

- **Search by size** – Limit the size of the files you wish to recover.
• **Deep Scan** – Attempt to recover files that are partially written over with new data. Processing time can increase with this option
• **Ignore Words** – terms and phrases defined here will not appear in the search results.
**File Organizer**

The File Organizer helps you organize your files by collections.

To begin, choose which collection of files you wish to organize. You can either drag and drop the files from Windows Explorer, from My Computer, or use the tool's Add feature. You can also enter full directory paths, like C:\Downloads from the example. Then set the destination directory to where you wish the files to be placed. For example, if you have downloaded music samples you might want to save them to C:\mp3\.

Next, click Simulate... and wait for the tool to create a suggested directory structure. If you are happy with the tool's suggestions, click Apply. Otherwise you can edit the structure.
The generated directory structure is easily edited by dragging files from one subdirectory to another or by removing the files in the suggested tree structure with the Delete key of your keyboard. When you are happy with the results, click Apply and the tool will create the directory structure in the specified destination directory and move the files there.
**Duplicate File Finder**

This tool uses a bit-by-bit analyzer for matching exactly identical files. Note that not all duplicate files are safe to delete. Duplicate File Finder is only recommended for use on your own document collections. Do not delete duplicate system files.

The Files to find section defines what kind of duplicate files you wish to search for. The default setting is “*.; -*.exe; -*.dll; -*.ocx; -*.sys; -*.vxd;” which ignores all important system file extensions.

The Search in section defines which directories will be analyzed. Notice that the this tool requires substantial system resources. Limiting the amount of directories or disks will help improve its performance.
Duplicate File Finder supports the following options:

- **Use as little CPU power as possible**
- **Skip files larger than 1 GB to improve speed**
- **Don’t pop up the window after finishing**
- **Ignore Words**
**File Tool**

The most powerful file handling tool included in jv16 PowerTools X is the File Tool. The File Tool is not designed to replace Windows Explorer but to augment it.

To access the File Tool you can either use the File Finder, the File Cleaner, or you can drag and drop files to the main window of jv16 PowerTools which automatically opens the File Tool.

The main panel shows a list of files. The File Tool can show common information about the files such as their sizes, creation dates and attributes. In addition, File Tool can extract...
information from executable files and MP3s. It can also calculate the CRC, SHA1 or MD5 checksums of files.

To see more options, select one or more files and click on the More Functions button. This provides access to the following features:

- **Analyze** uses AI (Artificial Intelligence) and statistical methods in order to guess the use and the contents of the file. See the File Analyzer chapter for more information.
- **Change attributes** adds or deletes attributes from the selected files. See the File Attribute Tool section for more information.
- **Copy to...** creates a copy of the selected files and sends them to the desired location.
- **Decrypt** decrypts the selected encrypted files.
- **Empty** clears the contents of the file. This feature was designed to empty log files, for example.
- **Encrypt** encrypts files with a wide range of options. Please see the File Encrypter section for more information.
- **Execute** opens the selected file with its default application as defined by the settings of the system.
- **Explore** opens Windows Explorer to the directory where the file is located.
- **Find & Replace** searches for data inside files and replace it with other data. The feature works in a similar way as the Registry Find & Replace.
- **Mass Rename** renames many files in a very easy but powerful way. See the Mass File Renamer section for more information.
- **Merge** combines two or more files. Note that the original files are not modified but a new file with the contents of all the selected files is created. The user is asked to enter the new file name.
- **Move to...** moves the selected files to the desired location.
- **Move to recycle bin** deletes the selected files and moves them to the Recycle Bin.
- **Remove on reboot** allows you to delete protected or locked files during the next system startup (assuming the protection is not yet active).
- **Rename** renames a single file. The user is asked to enter the new file name.
- **Split** splits files into multiple parts.
- **View** opens the selected file with jv16 PowerTools default file viewer.
- **Wipe** overwrites files before deleting them.

The different tools under the More Functions button have different requirements which must be met before you can use them, as explained in the following table:
<table>
<thead>
<tr>
<th>Feature</th>
<th>Number of files which need to be selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze...</td>
<td>One file only</td>
</tr>
<tr>
<td>Change Attributes...</td>
<td>One or more files</td>
</tr>
<tr>
<td>Copy To...</td>
<td>One or more files</td>
</tr>
<tr>
<td>Decrypt</td>
<td>One or more files</td>
</tr>
<tr>
<td>Empty</td>
<td>One or more files</td>
</tr>
<tr>
<td>Encrypt</td>
<td>One or more files</td>
</tr>
<tr>
<td>Execute</td>
<td>One file only</td>
</tr>
<tr>
<td>Explore</td>
<td>One file only</td>
</tr>
<tr>
<td>Find and Replace...</td>
<td>One or more files</td>
</tr>
<tr>
<td>Mass rename...</td>
<td>Two or more files</td>
</tr>
<tr>
<td>Merge</td>
<td>Two or more files</td>
</tr>
<tr>
<td>Move To...</td>
<td>One or more files</td>
</tr>
<tr>
<td>Move to Recycle Bin</td>
<td>One or more files</td>
</tr>
<tr>
<td>Remove on Reboot</td>
<td>One or more files</td>
</tr>
<tr>
<td>Rename...</td>
<td>One file only</td>
</tr>
<tr>
<td>Split...</td>
<td>One or more files</td>
</tr>
<tr>
<td>View</td>
<td>One or more files</td>
</tr>
<tr>
<td>Wipe</td>
<td>One or more files</td>
</tr>
</tbody>
</table>

**Tip:** You can drag and drop files to the File Tool directly from Windows Explorer or from My Computer. You can also drag and drop files to the main window of jv16 PowerTools which will automatically open the File Tool, listing the files.
Mass File Renamer

Renaming several files at once is labor intensive without a Mass File Renamer tool. jv16 PowerTools' File Renamer is not just any renamer tool, it's one of the most advanced on the market thanks to its unique user interface.

You can access the Mass File Renamer from the File Tool. Drag and drop files to be renamed onto the main window of jv16 PowerTools and the File Tool opens. Select the files and click More Functions > Mass Rename and the files are in the Mass File Renamer.

The Mass File Renamer builds up the names of the files from different parts.

In the example above, two parts of a new filename are shown:
1. The first part contains the primary name of the file; “jv16pt”.
2. The second part is data copied from the original name, from the 1\textsuperscript{st} letter to the 50\textsuperscript{th}.

When you click on Start, the files will be renamed accordingly. You can reorder the different parts of the name around any way you like with drag and drop. Just grab the block with your mouse and drop it where you wish. You can delete any block by grabbing it and clicking on Delete.

Use the Simulate... button to check your renaming pattern before it is applied. Click on Start when you are ready to proceed.

---

**Warning:** Changes made by the Mass File Renamer tool are permanent. Check your changes before clicking on Start.
**File Attribute Tool**

Editing file attributes in multiple files is accomplished with the File Attribute Tool.

You can access the File Attribute Tool from the File Tool. Just drag and drop your files to the main window of jv16 PowerTools and the File Tool opens. Select the files and select More Functions > Change attributes.

![File Attribute Tool](image)

**Warning:** The changes made by the File Attributes Tool are permanent. Check your changes before clicking on Start.
Find & Replace

Replacing data within multiple text files is easy with the Find & Replace tool. The tool is not designed for binary files. Use it on plain text, html and xml files.

You can access the Find & Replace feature from the File Tool. Drag and drop your files to the main window of jv16 PowerTools and the File Tool opens. Select the files and click More Functions > Find & Replace.
The Find & Replace Results

The Find & Replace feature uses the same approach as the Registry Find & Replace tool discussed earlier.

The results of the search operation are listed in a new window. In picture above “not” is changed into “NOT” to emphasizes the importance of not doing something. Remove the items you do not wish to be changed using the options from the right click menu. Open files in the same manner.
Click the Replace button after you have verified your list. Cancel the Find & Replace procedure by clicking the Close button.
**File Encrypter**

The File Encrypter protects your files from being viewed or edited by unauthorized parties.

You can access the File Encrypter from the File Tool. Drag and drop your files onto the main window and the File Tool opens. Select the files and click More Functions > Encrypt.

![File Encrypter interface](image)

The File Encrypter of jv16 PowerTools supports most modern data encryption algorithms and additionally contains three very advanced and unique ways to greatly improve your security: Encryption of the file name; allowing decryption only on a computer with a specific name; and allowing decryption only by a user with a specific name.
The features of the File Encrypter are as follows:

- **Also encrypt the filename** increases your privacy by encrypting the name of the file to prevent guessing the file's contents. After you decrypt the file, the original file name is restored.
- **Decryption only on a computer named...** makes decryption possible only on a particular computer.
- **Decryption only by a user called...** makes decryption possible only by a particular user.
- **Algorithm box** lists all the encryption algorithms available.
- **Key generator box** lists all supported key generators.

To decrypt a file, click the Decrypt button in the File Tool and enter the correct password.

The following data encryption algorithms are supported:

- 3Way
- 3DES
- Blowfish
- Diamond II
- FROG
- Gost
- Q128
- Rijndael
- Safer-SK128
- Sapphire II
- SCOP
- Shark
- Skipjack
- Square
- Tea
- Twofish
File Analyzer

Use the File Analyzer to help determine the contents of an unknown file. Access the File Analyzer from the File Tool by dragging and dropping files to the jv16 PowerTools' main window. Select the files and click More Functions > Analyze.

The File Analyzer does not analyze the extension of a file, nor certain header or footer information. The Analyzer uses a unique method of combined statistical and Artificial Intelligence data recognition.

Data content shows the probability of the file's contents, whether in a natural language such as English, or otherwise.
The File contents box contains the following:
- **File type** – An estimation of the file type based purely on the contents of the file
- **Language** – A statistical estimation of the language of the contents in the case of ASCII text data.

The General box contains the following statistical information about the contents of the file:
- **Data length** – The length of the data in bytes.
- **Distribution** – How well the data is distributed; a numerical representation of the Relative character distribution image.
- **Max value** – Largest byte value. The largest possible value is 255 and the smallest 0.
- **Avg value** – Average byte value found.
- **Min value** – Smallest byte value found.
- **Words** – Estimated number of words found in the file if its contents are a text file.
- **Lines** – Estimated number of the word lines in the file.

The Averages box contains the following statistical information:
- **Word length** – Average word length.
- **Line length** – Average length of a single line.
- **Words per line** – Average number of words per line.
Directory Finder

The Directory Finder searches for specific directories.

Search options include:

- **Search by size** – Search for directories that contain a range of sizes or a specific size.
- **Search by contents** – You can search for directories which contain a certain number or range of files and sub directories. You can also search for directories that contain only files of a certain size or range of sizes.
- **Search by date** – Search for directories by creation date, last modified date, or last accessed date.
You can also freely combine these different search methods. For example, search for all directories with "temp*" in their name that contain at least one file and which have not been accessed within the last seven days. Search results are shown with the Directory Tool.
The Directory Tool is similar to the File Tool. It first lists a series of directories, allowing you to perform several different operations on directories. You list directories with the Directory Tool by either using the Directory Finder discussed above, or by dragging directories into the main window.

The More Functions button gives you access to the following features:

- **Delete all files from the directory and its subdirectories** – The directory structure
remains intact.

- **Explore** opens the Windows file explorer to the selected directory.
- **Recycle** deletes the directory with all sub directories and files and moves them to the Recycle Bin.
- **Rename** renames a single directory. The user is asked to enter the new name.
- **Wipe** deletes all the contents of the directory by overwriting the data before freeing the space.

The subdirectories, Files and Size of contents columns show “N/A” if the directories were dragged. The data is shown only if the Directory Finder was used.
The Disk Wiper deletes data from your hard drive to make it nearly impossible to restore. It accomplishes this by overwriting the data before freeing the space. The number of overwrites can be configured from the Settings window.

The tool has three different operating modes:

1. Wipe only the free space of the hard drive
2. Wipe all files and directory structures
3. Wipe all data, free space, directory structures and files

The Disk Wiper destroys all the metadata stored on disk including:

- File names
- Directory names
- File attributes
- All contents of the files and directories

**Tip:** The Disk Wiper is designed to wipe large amounts of data at a time. You can wipe individual files with the File Tool, and entire directories can be wiped with the Directory Tool.
History Cleaner

Many applications remember the last files you opened, the last directories you worked with or what movies you last watched. These features can be useful, but they can also create potential privacy issues.

Clearing the history items and MRU (Most Recently Used) lists of third party applications is very time consuming without a good tool. The History Cleaner makes the task very easy and fast. Simply select the applications whose history information you wish to remove and click Clear.
The History Cleaner can also show you items found in the registry and on hard drive(s). Simply right-click on an item and select Show data... to see a list of registry entries and files which are related to the selected software.
**Automation**

Automate often used jv16 PowerTools utilities such as the File Cleaner with the Automation Tool.

You can use the Automation Tool to run automated tasks you have already created, or to create new ones:
To create a new Automation Tool task, click the Create new task... button. Select the actions you wish to be performed.

Select the Start type. This defines the way you want to use the task. For example, you can ask jv16 PowerTools to create an icon of the task to the Desktop to launch it from there, or you can set the task to be automatically executed when the system is started. You must also give the task a description and a file name in the Options section. After you have filled both fields, click OK and you're done.

**Warning:** The Automation Tool does not create backups. Verify any actions before applying automation to any task.
Service Manager
The Service Manager augments Windows' Services tool.

You can use the Service Manager to disable services you no longer need and remove left-over services from software you have already removed.

The Optimize feature quickly analyzes your system and makes a suggestion what services
could be disabled in order to improve the start up time of your computer.

**Warning:** Verify any actions before disabling or deleting any services.
Appendixes

Command Line Parameters

jv16 PowerTools X supports the command line parameters listed in the table below. Command line parameters can be used from Windows' Command Prompt or by creating a shortcut and adding the command line parameter after the file name. For example:

"C:\Program Files\jv16 PowerTools X\jv16pt.exe" -FileTool

<table>
<thead>
<tr>
<th>Command line parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-AutomationTool</td>
<td>Opens the Automation tool</td>
</tr>
<tr>
<td>-BackupTool</td>
<td>Opens the Backup tool</td>
</tr>
<tr>
<td>-CleanAndFix</td>
<td>Opens the Clean and Fix My Computer tool</td>
</tr>
<tr>
<td>-DirFinder</td>
<td>Opens the Directory Finder</td>
</tr>
<tr>
<td>-DirTool</td>
<td>Opens the Directory tool</td>
</tr>
<tr>
<td>-DiskWiper</td>
<td>Opens the Disk Wiper</td>
</tr>
<tr>
<td>-DuplicateFinder</td>
<td>Opens the Duplicate File Finder</td>
</tr>
<tr>
<td>-FileFinder</td>
<td>Opens the File Finder</td>
</tr>
<tr>
<td>-FileCleaner</td>
<td>Opens the File Cleaner</td>
</tr>
<tr>
<td>-FileOrganizer</td>
<td>Opens the File Organizer</td>
</tr>
<tr>
<td>-FileRecovery</td>
<td>Opens the File Recovery</td>
</tr>
<tr>
<td>-FileTool</td>
<td>Opens the File tool</td>
</tr>
<tr>
<td>-HistoryCleaner</td>
<td>Opens the History Cleaner</td>
</tr>
<tr>
<td>-RegCompact</td>
<td>Opens the Registry Compactor</td>
</tr>
<tr>
<td>-RegFinder</td>
<td>Opens the Registry Finder</td>
</tr>
<tr>
<td>-RegFindReplace</td>
<td>Opens the Registry Find &amp; Replace tool</td>
</tr>
<tr>
<td>-RegInformation</td>
<td>Opens the Registry Information</td>
</tr>
<tr>
<td>-RegManager</td>
<td>Opens the Registry Manager</td>
</tr>
<tr>
<td>-RegMonitor</td>
<td>Opens the Registry Monitor</td>
</tr>
<tr>
<td>-Settings</td>
<td>Opens the Settings window</td>
</tr>
<tr>
<td>Command line parameter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>-SoftwareUninstaller</td>
<td>Opens the Software Uninstaller</td>
</tr>
<tr>
<td>-StartupManager</td>
<td>Opens the Startup Manager</td>
</tr>
<tr>
<td>-ExecTask “C:\filename.jvb”</td>
<td>Executes an automated task created by the Automation tool</td>
</tr>
</tbody>
</table>

**Security Notes**

If you wish to use the security features of jv16 PowerTools (the features under the Security tab in the Settings window) you should remember the following notes:

1. After you have set up the desired security mode under the Security tab in the Settings window, write protect the \Settings\Security.dat file to prevent unauthorized modifications of this setting. Protecting the file is only possible if jv16 PowerTools has been installed on an NTFS partition. If the file is not write protected, any user could change the security mode setting and thus bypass the security settings.

2. Using the Demand a password feature only when the normal GUI is started. Security mode is not recommended to be used in a hazardous environment. The Security mode can be bypassed with a specially formatted automation task which starts the normal user interface, and because the user interface was started from an automation task instead of directly no password is asked.

**Installing the Handbook and languages**

When installing the software, you are asked what packages you wish to install on your computer. The Handbook might not be preselected, so you will need to make sure that the 'tick' is as follows in the Image 68, for the Handbook to be installed. Here you can also choose what translations are downloaded to your computer. English is the only mandatory language to be downloaded.


**Initial Setup**

The Initial Setup needs to be run when the program is first installed and after that, it is automatically ran on average twice a month. This ensures the program's internal caches contain valid and fresh data.

**Frequently Asked Questions – with their answers**

These are the most commonly asked questions. Before contacting us, you should quickly read these items to see if your question is already answered here.

**Question:** How can I update to PowerTools X? How do I register my copy of PowerTools X? I bought a license, how do I get the full version?
**Answer:** If you own a license for jv16 PowerTools X or you own a Platinum VIP license, you can update by following these steps:

1. Download the free trial version of PowerTools X. [Click here to download it](#) if you haven’t done so already.
2. Install PowerTools X. Install it to a new directory, you do not need to uninstall PowerTools 2014 if you want to keep both versions. If you only want the latest version, feel free to uninstall the old version first.
3. Open PowerTools X and open the My Account feature.
4. Enter your name and email address to the My Account feature. Be sure to use the same information you used with your order.

After you have entered your information, the My Account feature should automatically download and install your license, and convert the trial version to the full version.

If the My Account feature doesn’t find your license, you can also try to manually download your license from [Download My License](#) page. The same page also lists all your previous orders. To manually download your license, click the correct Download button to download your license, save the license file to the installation directory of PowerTools (by default: C:\Program files (x86)\jv16 PowerTools X\). After doing that, use PowerTools X’s My Account feature’s “Install new license” button to open the license file.

**Question:** What license do I own? Can I update to PowerTools X?

**Answer:** If you are unsure what license you own, please use the [Download My License](#) page. The page lists all your previous orders and tells you about your update options.

**Question:** Who is entitled for a free update to jv16 PowerTools X?

**Answer:** You can update to PowerTools X for free if you are our Platinum VIP customer or if you have bought jv16 PowerTools 2014 in the August of 2014 or later. For instructions how to update, see the answer to question **How can I update to PowerTools X**.

Also, if you participated to our Crowdfunding campaign last year, you may be entitled for a free update as well. In such case, you should contact [crowdfunding@macecraft.com](mailto:crowdfunding@macecraft.com) with your contribution payment details (the name and email address used with the contribution) and we
will issue you the correct license.

If you are unsure what license you own, please use the Download My License page. The page lists all your previous orders and tells you about your update options.

**Question:** What is the update price of jv16 PowerTools X?

**Answer:** The update price for our old customers is only $5.95 USD. To be able to buy the update with this price, please use this link: [https://www.macecraft.com/upgrade-ptx/](https://www.macecraft.com/upgrade-ptx/)

The $5.95 USD update price is available only to our old customers. The checkout page asks for the email address you used with your previous order. Only if an existing order is found with that email address, you can buy the update with the discounted price.

**Note:** Please verify the price before proceeding with the payment, to ensure you get the discounted update price of $5.95 USD.

The normal price of jv16 PowerTools X for new customers is only $29.95 USD. You can buy a license from: [https://www.macecraft.com/checkout/](https://www.macecraft.com/checkout/)

**Question:** How can I unsubscribe?

**Answer:** You can unsubscribe from our mailing list by using the Unsubscribe page. Our software is sold as one time purchase, which means we do not have any subscription based services (reoccurring payments).

**Question:** Where I can download translations for PowerTools? I installed PowerTools but it didn’t include any translations?

**Answer:** When you install jv16 PowerTools, you must choose from the setup program which languages you wish to install. If you didn’t see this option, you can get all the translations to jv16 PowerTools either by re-installing the software (if you don’t uninstall first, you won’t lose any of your settings or backups). You can also download individual translations from the Download Translations page.